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ABSTRACT
This project is based on utility survey of  ROYAL VALLEY ESTATE 
at kunlende/akerebiata road, ilorin ilorin east local government area kwara state 
 This project has been divided into different chapters.Chapter one of this project gives an introduction about the project topic as a whole.This enables better understanding of the project so as to know what perimeter and detailing entails as well as the scope and aim of the project.Chapter two is the literature review i.e. the works of past professionals and projects that had been done in the past as regards this specific topic which were examined in order to help to shed more light on what perimeter and detailing survey is all about. Chapter three of this project is the methodology which describes how the project was carried out using digital instrument e.g. Total Station and its accessories from the first stage to the final stage.Chapter four of this project is Data presentation which consists of all the data acquired from site during the project execution. Chapter five comprises of summary, problems encountered, conclusion and recommendations. Reference comprises of list ofnames and works of prominent authors or professionals whose works on survey as regards this specific topic were used in the course of this project.
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1.0 INTRODUCTION
A utility survey is a systematic process used to detect, locate, identify, and map underground utility infrastructure, such as water pipelines, gas mains, sewer lines, electrical conduits, fiber-optic cables, and other essential subsurface services. These surveys serve as a foundational component in modern construction, engineering design, and urban planning. The primary objective of a utility survey is to provide accurate, up-to-date information about existing underground utilities to support safe excavation, informed decision-making, and efficient infrastructure development.

As cities continue to grow and infrastructure becomes more complex, the need for precise utility data has become increasingly critical. Inaccurate or missing information about buried services can result in severe consequences, including service interruptions, costly project delays, environmental hazards, and even fatalities due to accidental strikes during excavation. Utility surveys help prevent such occurrences by delivering reliable data that guides planners, engineers, and contractors during construction and maintenance activities.

Traditionally, the documentation of subsurface utilities has been fragmented, often relying on outdated maps, inconsistent record-keeping, and anecdotal knowledge. However, with advancements in technology, modern utility surveys now incorporate high-precision tools such as Ground Penetrating Radar (GPR), electromagnetic locators, GPS/GIS systems, and even drone-assisted mapping to enhance detection accuracy and data visualization.

Moreover, utility surveys play a vital role in promoting sustainable development. By enabling informed planning and reducing the likelihood of infrastructure conflicts, these surveys contribute to the longevity and resilience of urban systems. They also facilitate inter-agency coordination, regulatory compliance, and public safety by ensuring that utility networks are properly documented, maintained, and accessible.

In light of these benefits and challenges, the study of utility surveying is essential to improving urban infrastructure practices. This research aims to explore the methodologies, technologies, and implications of utility surveys, highlighting their significance in shaping safe, efficient, and intelligent urban environments.
The significance of utility surveys extends beyond construction logistics—they are a vital tool in the lifecycle management of urban infrastructure. In the absence of reliable subsurface utility data, projects face heightened uncertainty, often leading to reactive measures that inflate costs and increase the risk of damage. According to the American Society of Civil Engineers (ASCE), inaccurate or incomplete utility information is one of the leading causes of construction delays and workplace accidents in developed and developing nations alike.

Modern urban environments are layered with increasingly dense and intertwined utility systems. As cities retrofit aging infrastructure and expand into previously undeveloped areas, the complexity of managing underground networks intensifies. In this context, utility surveys are not merely a procedural step, but a strategic necessity. They support a proactive approach to infrastructure development, allowing stakeholders to anticipate risks, optimize designs, and allocate resources more effectively.

Technological innovation has revolutionized the practice of utility surveying. Ground Penetrating Radar (GPR), electromagnetic induction, acoustic locating techniques, and GPS/GIS mapping have drastically improved detection precision and data presentation. These tools have enabled engineers and surveyors to produce three-dimensional utility maps that not only depict location and depth but also reveal the condition and material of buried assets. Additionally, the integration of Artificial Intelligence (AI) and cloud-based data platforms is opening new avenues for real-time analysis, predictive maintenance, and cross-organizational data sharing.
Beyond technology, utility surveys hold important implications for sustainable development and resilience. Accurate utility mapping helps reduce unnecessary excavation and material waste, thus lowering a project’s environmental impact. It also enhances a city’s capacity to respond to emergencies—such as utility leaks, electrical faults, or water main bursts—by providing immediate access to critical subsurface information.

Furthermore, utility surveys promote transparency and accountability in urban governance. As municipalities and utility providers strive to modernize infrastructure, the standardization of subsurface data collection and reporting ensures consistency across projects and jurisdictions. It fosters collaboration between public and private stakeholders, including engineers, planners, utility companies, and regulatory agencies.


STATEMENT OF THE PROBLEM

Despite their critical importance to urban infrastructure and development, utility surveys face several persistent challenges that limit their effectiveness. One of the most pressing issues is the lack of reliable, up-to-date data on the location and condition of underground utilities. This information gap often leads to accidental utility strikes during excavation activities, resulting in serious safety hazards, construction delays, and substantial financial losses.

Complicating matters further, existing utility records are frequently incomplete, outdated, or poorly maintained. In many cases, access to these records is restricted due to legal, bureaucratic, or institutional barriers. As urban environments become more complex and utility networks grow more intertwined, conventional surveying techniques are proving insufficient to meet current demands. The limitations of traditional methods are particularly evident in densely populated or rapidly developing areas, where infrastructure systems are layered, congested, and often undocumented.

These challenges highlight the need for more advanced and reliable utility surveying practices. There is a growing urgency to develop improved methodologies, promote better data-sharing protocols, and integrate cutting-edge technologies such as GIS, ground-penetrating radar (GPR), and AI-driven tools. This study seeks to address these critical gaps by exploring innovative solutions that enhance the accuracy, safety, and efficiency of utility surveys in urban infrastructure management.


AIM OF THE STUDY

The overarching aim of this study is to investigate and promote effective utility survey practices by examining modern technologies, methodologies, and collaborative frameworks. Specifically, the research seeks to contribute to safer and more efficient urban development by enhancing the ability to accurately detect, identify, and map subsurface utilities such as water mains, electrical lines, gas pipes, sewage systems, and telecommunications networks. Through this, the study aspires to reduce the incidence of utility strikes, support efficient project planning, and encourage sustainable urban growth.






OBJECTIVES OF THE STUDY



Ø To investigate and apply advanced utility detection techniques such as ground-penetrating radar (GPR), electromagnetic location tools, and GPS/GIS systems.

Ø To generate accurate and current data on underground utilities that informs design, planning, and construction processes.

Ø To minimize the risk of accidents, service disruptions, and financial losses caused by unintentional utility damage during excavation.

Ø To support informed decision-making in urban planning, emergency response, and infrastructure development through reliable utility data.

Ø To identify and analyze inconsistencies or gaps in existing utility records and propose methods to improve data quality.

Ø To foster improved coordination among engineers, contractors, utility providers, and planners by advocating standardized data-sharing frameworks.



PROJECT SPECIFICATION

This study will deliver a comprehensive review and evaluation of utility surveying practices, covering a blend of traditional methods and emerging technologies. The key focus areas include:

Exploration of theoretical frameworks and foundational concepts related to utility surveying.

Analysis of real-world case studies that demonstrate practical applications in various urban settings.

Review of technological innovations, including GIS integration, artificial intelligence, remote sensing, and drone-assisted surveys.

Assessment of the regulatory and institutional environment that governs utility surveying practices.

Formulation of recommendations and best practices aimed at improving the accuracy, safety, and coordination of utility surveys in construction and infrastructure projects.

SCOPE OF THE STUDY

This research will focus on the role of utility surveys within the context of urban infrastructure development. It will draw on literature and case studies from a range of geographic locations to assess how regional differences in regulation, technology, and infrastructure influence survey practices. Particular attention will be given to the integration of utility surveys in urban planning, construction risk management, and emergency response systems.

While the study centers on the technical aspects—such as methodologies, tools, and data systems—it will also acknowledge the broader socio-political and environmental contexts in which utility surveys are conducted. These contextual factors, although not the primary focus, are essential for understanding the challenges and opportunities in implementing effective utility survey strategies.
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1.9	STUDY AREA								

The study area is located at royal Valley estate, At Kunlende/akerebiata road, ilorin ilorin East Local government area Kwara State 
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CHAPTER TWO

LITERATURE REVIEW ON UTILITY SURVEYS

Introduction

Utility surveys are essential in infrastructure planning, construction, and maintenance. These surveys help identify and map underground utilities such as water pipes, gas lines, electricity cables, telecommunications conduits, and sewage systems. In today’s complex urban environments, where utilities are densely packed and often poorly documented, accurate surveying is vital to prevent costly errors, delays, and potential hazards. This review explores the historical context, methodologies, technologies, applications, challenges, and future directions of utility surveys.




Methodologies in Utility Surveys

Various methodologies are used to detect, locate, and document underground utilities. These approaches have evolved from traditional visual inspections to sophisticated geophysical technologies.

Desktop Utility Records Review
This method involves reviewing historical utility records such as as-built drawings and GIS databases. While cost-effective, these records are often incomplete or outdated, necessitating on-site validation.

Visual Inspection and Site Reconnaissance
Physical site visits allow surveyors to observe visible infrastructure such as manholes, valves, and utility markers. However, this technique only reveals surface-level data.

Geophysical Survey Techniques
Modern surveys commonly rely on geophysical methods:

Ground Penetrating Radar (GPR): Uses radar pulses to detect changes in subsurface materials. GPR is effective for both metallic and non-metallic utilities but can be limited in high-clay or wet environments.

Electromagnetic Location (EML): Detects metallic pipes or cables by tracking electromagnetic signals. It is reliable for metallic assets but not suitable for plastic or ceramic pipes.

Other Geophysical Methods: Techniques such as magnetometry, seismic methods, and resistivity mapping are occasionally employed for specific applications or geological conditions.


Vacuum Excavation (Potholing)
This technique physically exposes the utility using air or water suction without causing damage. It offers high accuracy and is often used to verify geophysical survey results.



Historical Development of Utility Surveys

The concept of mapping utilities dates back to the early 20th century when urbanization accelerated the demand for coordinated underground infrastructure. Initially, utility placement was documented manually, often with limited precision. Early surveys relied heavily on human memory and handwritten maps, which led to frequent conflicts between different utility service providers.

As infrastructure networks grew in complexity, especially post-World War II, the need for systematic and standardized documentation became evident. The rise of urban planning in the 1960s and 1970s brought about increased awareness of the dangers posed by poorly mapped underground utilities. This period saw the adoption of photogrammetry, aerial mapping, and early geophysical methods.

In the 1990s and early 2000s, the integration of GPS, GIS, and early CAD systems revolutionized utility documentation and spatial analysis. This shift also marked the beginning of a move toward digitization, centralization of records, and the early stages of what would become smart infrastructure systems.



Role of Utility Surveys in Risk Management

One of the most critical aspects of utility surveys is risk mitigation. According to the Common Ground Alliance (CGA), utility strikes remain a significant risk on construction sites, leading to injuries, delays, legal liabilities, and costly repairs. Comprehensive surveys reduce these risks by:
Identifying conflict zones in design and planning stages.

Preventing service outages, especially for essential services like gas, electricity, and water.

Minimizing excavation errors, especially in congested or urbanized areas.

Supporting insurance claims and legal documentation in the event of accidents.


Additionally, survey data contributes to infrastructure asset management, allowing municipalities and private firms to better allocate resources, plan maintenance, and forecast long-term needs.



Ethical and Social Considerations

Utility surveying also encompasses ethical dimensions, particularly in how data is collected, shared, and used. Key considerations include:

Data Privacy: Utility data can reveal sensitive information about infrastructure, access points, and usage patterns. Improper handling or exposure of such data could pose security risks.

Public Safety: Surveyors have a responsibility to ensure their work minimizes risks to the public. This includes clear communication with local authorities and adherence to safety protocols during physical inspections.

Equity and Accessibility: In developing regions, access to modern surveying tools and accurate utility data is limited. This can perpetuate infrastructure inequalities and contribute to service disruptions or environmental hazards.


The ethical management of utility survey data is an emerging topic, with calls for standardized data governance frameworks and improved transparency in data collection practices.



Cross-Disciplinary Integration

Utility surveying increasingly intersects with other fields, making it a multi-disciplinary domain:

Civil Engineering: Uses utility survey data to design foundations, roadways, and public works while avoiding existing utilities.

Environmental Science: Survey data helps identify and mitigate risks associated with leaking pipelines or chemical spills.

Urban Planning: Accurate utility mapping supports sustainable development and future-proofing of cities.

Computer Science and Data Analytics: AI, machine learning, and data visualization tools enhance the interpretation of geospatial data and real-time monitoring.


This integration is leading to the emergence of “Digital Twin” cities — virtual replicas of real urban environments where utility networks are mapped, monitored, and managed digitally.



Global Perspectives and Case Studies

Utility surveying practices vary significantly across countries due to differences in regulations, infrastructure maturity, and technological access.

United Kingdom: The UK is a leader in utility survey standardization, with the PAS 128 standard widely adopted across public and private projects. Programs like the National Underground Asset Register (NUAR) aim to centralize utility data nationally.

United States: The ASCE 38-22 standard defines quality levels of utility data, supporting utility coordination and risk management. However, enforcement and adoption vary by state.

Developing Nations: In many parts of Africa, Asia, and South America, utility surveys are still largely manual, and records are sparse. However, mobile technologies, low-cost drones, and open-source GIS platforms are helping bridge the gap.


Case Study: Crossrail Project, London
The Crossrail railway project is a well-documented example of large-scale utility survey integration. The project faced thousands of utility conflicts, requiring advanced GPR, EML, and vacuum excavation technologies. A centralized GIS-based model helped manage data and reduce risks, saving millions in potential delays.


Educational and Workforce Implications

As utility surveying becomes more technology-driven, there is a growing need for a skilled workforce trained in both field techniques and digital tools. Key areas of focus include:

Technical Training: Surveyors must be proficient in GPR operation, GIS software, and CAD integration.

Interdisciplinary Curriculum: Universities and technical institutions are encouraged to incorporate utility surveying into civil engineering, urban planning, and data science programs.

Certification and Standards Compliance: Professionals should be educated on compliance with national and international standards, such as PAS 128, ASCE 38-22, and ISO guidelines.


The professionalization of utility surveying is critical to ensuring quality and safety across projects.



Recommendations for Future Research

Given the complexity and importance of utility surveys, several research areas warrant further exploration:

Automated Feature Extraction: Developing AI models to automatically interpret GPR or EML signals and identify utilities with minimal human input.

Subsurface 3D Modeling: Improving subsurface modeling techniques using multi-sensor data fusion and real-time visualization.

Utility Data Sharing Platforms: Creating open, interoperable databases for utility data sharing among stakeholders.

Impact of Climate Change: Studying how shifting water tables, soil erosion, and extreme weather affect underground utilities and survey methods.



Technologies and Innovations

Technology has significantly enhanced the accuracy, efficiency, and usability of utility surveys.

Geographic Information Systems (GIS)
GIS enables the integration and visualization of spatial utility data. It is widely used for planning, asset management, and decision-making in urban development projects.

Building Information Modeling (BIM)
BIM combines architectural, engineering, and utility data into a single 3D model. This integration aids in clash detection and planning for infrastructure projects.

Drones and UAVs
While not used directly for underground utility detection, drones help map terrain and identify surface features that correlate with buried infrastructure.

LiDAR and Photogrammetry
These technologies are used to create detailed 3D maps of the surface environment, which can be integrated with subsurface data to improve planning and coordination.


Applications of Utility Surveys

Utility surveys are critical across a variety of sectors and use cases.

Urban Planning and Construction
Proper utility mapping ensures efficient planning and helps avoid construction delays and safety hazards.

Transportation Projects
Highways, railways, and airport expansions require detailed surveys to locate and manage underground utilities before excavation begins.

Environmental and Risk Assessment
Surveying can help identify aging or leaking infrastructure that may pose environmental or health risks.

Emergency Services and Disaster Recovery
Accurate utility maps are essential for emergency responders to avoid electrical or gas hazards during rescue operations or natural disasters.
Challenges in Utility Surveys

Despite advancements, several challenges continue to affect the accuracy and reliability of utility surveys.

Data Inaccuracy and Gaps
Many utilities lack comprehensive or updated records. As-built drawings may be missing, incorrect, or inconsistent.

Technical Limitations
GPR and EML, though powerful, have limitations in specific soils, depths, and environments. Signal overlap and interference can reduce clarity.

Regulatory and Legal Issues
There is often no standardized requirement for utility data accuracy, making it difficult to ensure consistency across jurisdictions.

Cost and Resource Constraints
High-precision surveys, especially those requiring excavation or advanced modeling, can be time-consuming and expensive.

Standards and Best Practices
To improve quality and reliability, various standards and protocols have been developed:

PAS 128 (UK): Specifies standards for detection, verification, and location of underground utilities.

ASCE 38-22 (USA): Classifies utility information by quality levels, from record-based data to physically exposed utilities.

ISO Standards: ISO 19439 and ISO 55000 provide frameworks for asset and utility management across infrastructure sectors.


These guidelines promote better project coordination, data integrity, and safety.



FUTURE DIRECTIONS

The future of utility surveying lies in deeper integration with smart technologies and more efficient data systems.

Artificial Intelligence (AI) and Machine Learning
AI can enhance geophysical data interpretation, helping detect patterns and automate decision-making processes.

Augmented Reality (AR)
AR systems may allow surveyors to visualize underground utilities in real time using smart devices, improving on-site decision-making.

Blockchain for Data Security
Blockchain technology could provide secure, traceable records of utility data, ensuring tamper-proof historical documentation.
Smart Utility Networks and IoT
Embedded sensors in pipelines and cables can transmit real-time location and status data, reducing the need for repeated surveys and improving infrastructure monitoring.












CHAPTER THREE
3.0 	METHODOLOGY 
This aspect refers to a system of methods and principles, rules used in a field of study to achieve the aim and objectives of this project. The modality to successful execute this project was carried out based on the survey rules and regulation, supervisor advice and departmental instructions.

3.1 	RECONNAISSANCE 
Reconnaissance survey is a preliminary stage for exploratory investigations conducted to gather initial data concern the choice of Site area of Subject before more detailed research or filed work commenced. Reasons for reconnaissance survey of the project area are the following;
i. To know the location of the site.
ii. To determine the preliminary area/perimeter of the land.
iii. To know the survey method suitable for the field data acquisition and the instrument need for the it.
Reconnaissance in this project involved preliminary investigations to gather information about the survey area before conducting a detailed survey, reconnaissance of this project was carried out in two way namely as follows.
i. Office planning
ii. Field Reconnaissance



3.1.1 	OFFICE PLANNING
It involved the process adopted in the collection of relevant data and specification about the as-built Surveying with the used of traversing survey method. During the office planning the given coordinate for control point PBIL 100, PBIL 107, and PBIL 110, was obtained and computed as shown in the table 3.1 below. The choice of equipment to be use for project was obtained from the survey store in the department of surveying and Geoinformatic, Kwara State Polytechnic, Ilorin, and it was handled accordingly to the survey rules and regulations and departmental instruction.
TABLE 3.1 Showing the list of the coordinate of the control pillars used 
	Stations
	Northing (m)
	Easting (m)

	PBIL 100
	939353.130
	648821.110

	PBIL 107
	939306.460
	648932.560

	PBIL 110
	939224.969
	649120.403



3.1.2 	FIELD RECONNAISSANCE 
Field recce and site visitation was conducted as preliminary survey for investigation of the basic information about a specified project area, location, or subject in the field. It allows the members of the groups to be familiar with the terrain, boundary lines, selection number of station required, Equipment that will be used for the job, pillars number PBIL 100, PBIL 107, and PBIL 110, used as a control for the project and so on. The stations points selected was Inter-visible to one another and finally a reconnaissance diagram was produced which was attached to this project























RECCE DIAGRAM


3.2	INSTRUMENT SELECTION
The equipment used for this project was grouped into two categories; 
i. Hardware 
ii. Software
3.2.1	Hardware used 
i. Total Station with its Accessories (KTS-442L)
ii. Reflector poles
iii. Field book
iv. Writing material (pen) 
v. Survey beacons
vi. Steel Tape (5m)
vii. Tripod Stand
3.2.2	Software used 
Below are the list of the software used during the project processing; 
i. AutoCAD 2007
ii. Notepad
iii. Microsoft word
iv. Microsoft Excel






3.3 	INSTRUMENT TEST 
The instrument test was carried out before it used for angular observation. The purpose of testing the instrument before used is to know the assurance and maybe other instrument is in good Condition the instrument was set up over station A and it was pointed a Sighted to station B whore a pole Is hold, and the angle was recorded for face left the instrument was turn to farce right on the same point and it was sighted to station B, where a pole is held at the same position and the angle was recorded. The distance between station A and B 1s 10m. The steel tape was hold at 60m an point A and it was extend to point B. the results for the instrument test was shown i to figure 3.3 below and table 3:2 below.Total station
LINE OF SIGHT
RANGING POLE
20M
STATION  X
TERRAIN
STATION  Y












Figure 3.1 showing the instrument set up for collimation test 

Table 3.2 showing the test of instrument result 
	STATION
	SIGHT
	FACE
	HORIZONTAL READING
	DEDUCED ANGLE

	A
	B
	L
	180 00’ 03”
	

	
	B
	R
	0000’ 00”
	180 00’ 03”


Different in horizontal circle reading: 180° 00’ 03’’
Horizontal collimation error 
= 180° 00’ 03’’
= 000° 00 03’’
 	Collimation error = 
Horizontal collimation error = 00 00’ 01”
Because the collimation  error falls within the allowable 01”. The instrument was in good condition.
3.4 	MONUMENTATION 
This is the process in which the beacon is being buried in to ground. On the project site there are same existing  beacons on the boundary lines m, nail with cap (bottle cork) was used as the 	station pegs.






18cm
15cm above the ground
60cm below the ground
18cm

30cm
Nail
Bottle cork
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	FIGURE 3.4	Diagram and Dimension of Pillars buried

3.5 	CONTROL CHECK 
The Control check was carried out to know the control point PBIL 100, PBIL 107, and PBIL 110, are still in their positions. The instrument was set on Control FP01107 and the temporary adjustment was carried out i.e centring, levelling, and focusing. Back site was taken to control PBIL 107 and it was recorded.
The fore sight was served to PEG1 and it was recorded Steel tape was used to measure the distance between PBIL 110 and PEGI and it was recorded. The data observed was computed for given coordinate and Observed Coordinate, as shown in the table 3.2 below.


TABLE 3.2	THE GIVEN COORDINATE OF THE CONTROL POINTS
	STATION
	NORTHING (m)
	EASTING (m)

	PBI 100
	939353.130
	648821.110

	PBIL 107
	939306.460
	648932.560

	PBIL 110
	939224.969
	649120.403



TABLE 3.3	The Backward Computation for the Given Controls pillars
	From station
	Bearing
	Distance
	
	
	Northing
      (m)
	Easting
     (m)
	To station

	
	
	
	
	
	899353.130
	688821.110
	PBIL 100

	PBIL 100
	1120 43̍ 17 ̎
	120.827
	-46.670
	111.450
	899306.460
	688932.560
	PBIL 107

	PBIL 107
	1130 27̍ 09 ̎
	204.758
	-81.491
	187.843
	899224.969
	689120.403
	PBIL 110


	PBIL 100 to PBIL 107
	BEARING = 1120 43̍ 17 ̎ 
	DISTANCE = 120.827m
	PBIL 107 to PBIL 110
	BEARING = 1130 27̍ 09 ̎ 
	DISTANCE = 204.758m
TABLE 3.4	Show the Observed Coordinate of the Controls Pillars
	Station
	Northing (m)
	Easting (m)

	PBIL 100
	939353.126
	648821.105

	PBIL 107
	939306.460
	648932.560

	PBIL 110
	939224.969
	649120.403



TABLE 3.5	Show the Backward Computation for the Observed Control Pillars
	From station
	Bearing
	Distance
	
	
	Northing
       (m)
	Easting
     (m)
	To station

	
	
	
	
	
	899353.126
	688821.105
	PBIL 100

	PBIL 100
	1120 43̍ 08 ̎
	120.830
	-46.666
	111.455
	899306.460
	688932.560
	PBIL 107

	PBIL 107
	1130 27̍ 09 ̎
	204.758
	-81.491
	187.843
	899224.969
	689120.403
	PBIL 110


	PBIL 100 to PBIL 107
	BEARING = 1120 43̍ 08 ̎ 
	DISTANCE = 120.830m
	PBIL 107 to PBIL 110
	BEARING = 1130 27̍ 09 ̎ 
	DISTANCE = 204.758m
TABLE 3.6	Show the Difference between the Given Control Points and the Observed Control Pillars
	STATION
	NORTHING (m)
	EASTING (m)

	PBIL 100
	0.004
	0.005

	PBIL 107
	0.000
	0.000

	PBIL 110
	0.000
	0.000



Therefore the difference between the given and observer bearing was 00 00’ 09” and 00 00’ 00” and the difference between the given and the observer linear distance was 0.0003m, 0.000m the results obtained fall within the allowable accuracy for both angular and linear observation.
It was concluded the instrument was in good condition and fit to be used for the project.  
3.6 	DATA AQUISITION 
This was carried out on the field using Total station with its accessories (KTS-442L) was used for coordinating the entire site for both the perimeter and details of the site. The Total station was set on the 	control Pillar PBIL 107, and the temporary adjustment was carried out centering, leveling and 	focusing. The coordinates of the occupied station was input after that the coordinates of the backsight was record as well and the observation was done to backsight pillar and the coordinates was take and check against the given. Having check and found accurate then the perimeter survey commenced for the entire project site.
3.6.1 	DETAILING SURVEY
The detailing survey was done immediately after completely carried out the perimeter traverse to determine the position of the features on the Site was fixed using radiation survey method. During this several stations was established to pick the coordinates of the details and the coordinates was stored on the total station as its observed. This was later downloaded. The details that was picked during the detailing survey was coded in different ways like Building edges as ‘BLD’, Electric Poles ‘EP’, Drainage ‘DR’, Roads Line ‘RD’, Spot Height ‘SP’ and so on.

CHAPTER FOUR
4.0   	DATA PROCESSING 
This involved several step to ensure accurate and reliable result. It explains the method used in capturing; processing, downloading, and analyzing the data acquired Data reduction in surveying involves various methods to simplify and summarize the collected data for analysis. These are some common methods of data reduction that involves  
· Combining multiple values into a single value. The average value is calculated by summing up all the values and dividing by the number of values.
· Least Square Adjustment (LSA) is a method of data reduction that involves minimizing the sum of the squared errors between observed and calculated values.
· Interpolation is a method of data reduction that involves estimating values between observed data points. 
· Spatial data reduction refers to the process of simplifying and reducing the complexity of spatial data, such as geographic information system (GIS) data, while preserving its essential characteristics.
4.1	DATA EDITING 
· Open excel
· Click on the desire file
· Set to delimited 
· Click on next
· Mack space and comma
· Click
· On next
· Then click on finish
4.3	DATA PROCESSING USING AUTOCAD
The plan produced digitally with AutoCAD software. The following are the procedure used:
STEP 1: Open Notepad
Open Notepad on your computer. You can find it in the start menu (Window)
STEP 2: Create a New File
Click on "file" "New" to create a new file
STEP3: Enter Coordinates
Enter your coordinates in the following format:
X. Y. Data
STEP 4: Save the Fil
Click on "File" > "Save as" and choose a location to save your file. "ALADA Coordinate" txt, 	and select "All files" as the file type.
	Importing the Coordinate File Into 2007 AutoCAD
	STEP 1: Double click AutoCAD
	Go under format
	Click on format after that pick your unit
	Drawing unit
	Type.... Decimal
	Precision... 0.000
	Angle type Degree/Min/See
	Precision Od00
	Clockwise.... 노
	Unit to scale Meters
	Direction control North 270d0
	Press "OK"
	STEP 2: Create a new drawing
	Click on "File" > "Name" to create a new drawing
	STEP 3: Import the coordinate file
	Click on "Tools" >"Reference" > "Import" and select "ALADA coordinate (.txt)" as the file 	type. Navigate to the location where you saved your coordinate file ("ALADA coordinate .txt") 	and select it.
STEP 4: Configure Import Setting. In the import select "Point" as the object type and choose 	the correct coordinate format (eg. X and Y) click "OK" to import the coordinates.
4.4	DATA EXTRACTION
The data recorded in the field book was picked to compute for the bearing and distance. Forward computation and backward computation after all necessary correction have been applied. Correction like slope correction, tension correction and standardization correction.





4.3  	BACK COMPUTATION 
The result get for forward computation was used for Back computation.
The following program was required for back computation 
i. Input N2-N1 to get N
ii. Input E2-E1 to get E
iii.Input  to get distance 
iv.Input shift tan to get the corrected bearing when there us more station repeat step ¡¡¡ and ii.



Table 4.1 Showing Boundary Coordinates 
	Station 
	Northing (m)
	Easting(m)

	FPO1107
	939366.406
	648932.560

	PL1
	939240.312
	648901.750

	PL2
	939309.331
	648780.785

	PL3
	939292.197
	648603.139

	PL4
	939438.718
	648619.716

	PL5
	939467.847
	648693.558

	PL 6
	939353.126
	648821.105






Table 4.1.1 Showing back computation for the boundary coordinate  
	FROM Station 
	BEARING 
	DISTANCE 
	ΔN
	ΔE
	N

	
	
	
	
	
	89

	PBIL 107
	204 58 29
	72.971
	-66.148
	30.810
	

	PL1
	299 42 28
	139.270
	69.019
	120.965
	

	PL2
	295 39 02
	193.739
	83.866
	174.646
	

	PL3
	16 40 37
	47.520
	45.521
	13.637
	

	PL4
	112 42 17
	79.980
	30.871
	73.782
	

	PL5
	113 13 14
	113.790
	54.721
	127.547
	

	[bookmark: _GoBack]PL6
	112 43 59
	120.870
	48.666
	455
	














TABLE 4.1.2	showing area computation for the boundary coordination using double latitude 
	ΔN
	ΔE
	product

	66.148
	× - 30.810
	= 2038.020

	66.148
	
	

	69.019
	
	

	-63.277
	× - 120.965
	=7654.302

	69.619
	
	

	83.866
	
	

	89.608
	× -174.646
	-=15649.679

	83.866
	
	

	45.521
	
	

	218.995
	× 13.637
	=2986.435

	45.521
	
	

	-30.871
	
	

	233.645
	× 73.782
	=17238.792

	-30.871
	
	

	-54.721
	
	

	148.653
	× 127.547
	=18883.716

	-54.721
	
	

	-46.666
	
	

	46.666
	× 111.455
	=5201.159

	-46.666
	
	

	00.000
	
	



Area = 




	=19176.374=> 1.9 hectares
	1.9 Hect meter square
Hectare=

= 1.9176374 Hectare

Linear Accuracy = 

EL=EDN=0.066
ED=EDE=0.072
Total length =793.100

 = 
=1:8000

	







CHAPTER FIVE
5.0 	SUMMARY, PROBLEMS ENCOUNTERRED, CONCLUSION, RECOMMENDATION
5.1 	SUMMARY 

5.2 	PROBLEM ENCOUNTERED 
i. Too much of rainfall which does not allowed site
ii. Unavailable of the group members due to dean's cup football tournament
iii. While taking observing there are some object obstructing the view when taking the observation e.g electric pole, building, tree etc.


5.3 	RECOMMENDATION
The department should considered the season and time that the students should be given the terminal project.
5.4 	CONCLUSION 
At the end the aim and objective of this project was achieved. It was carried out using third order surveying method this project was carried out in accordance with survey rules and regulation and departmental instruction.















	Name
	Code
	E
	N
	h
	 
	PT260
	SH
	668115.4
	937791.5
	317.946

	PT1
	ST17
	668069.6
	937900.4
	324.137
	 
	PT261
	SH
	668118
	937790.7
	318.041

	PT2
	CV
	668071.1
	937900.4
	324.553
	 
	PT262
	SH
	668117.7
	937795.6
	317.967

	PT3
	CV
	668072
	937900.3
	324.541
	 
	PT263
	SH
	668113.5
	937797.2
	317.656

	PT4
	BLD
	668072.6
	937900.6
	324.383
	 
	PT264
	SH
	668110.1
	937800.8
	317.647

	PT5
	BLD
	668066.5
	937905.8
	323.724
	 
	PT265
	SH
	668110.4
	937806.9
	317.571

	PT6
	SH
	668069.7
	937897.9
	324
	 
	PT266
	SH
	668114.1
	937808.4
	317.326

	PT7
	SH
	668072.6
	937896.1
	324.671
	 
	PT267
	SH
	668117.8
	937810
	317.601

	PT8
	SH
	668072.2
	937891.5
	324.604
	 
	PT268
	SH
	668117.6
	937814.7
	317.532

	PT9
	SH
	668076.5
	937892.6
	324.821
	 
	PT269
	SH
	668113.8
	937816
	317.212

	PT10
	SH
	668083.2
	937892.3
	324.831
	 
	PT270
	SH
	668109
	937815.1
	317.485

	PT11
	SH
	668085.6
	937889.4
	324.87
	 
	PT271
	SH
	668104.5
	937814.4
	317.27

	PT12
	BLD
	668085.4
	937886.8
	324.848
	 
	PT272
	SH
	668104.8
	937819.5
	317.197

	PT13
	SH
	668088.7
	937888.5
	324.887
	 
	PT273
	SH
	668109.7
	937818.5
	317.278

	PT14
	SH
	668090.4
	937893.3
	324.882
	 
	PT274
	SH
	668113.6
	937819
	317.192

	PT15
	SH
	668095.3
	937895.1
	324.957
	 
	PT275
	SH
	668117.7
	937821.2
	317.334

	PT16
	SH
	668095.6
	937891.4
	324.958
	 
	PT276
	SH
	668114.1
	937823.2
	317.152

	PT17
	BLD
	668139.4
	937901.3
	324.586
	 
	PT277
	SH
	668109
	937824.1
	317.181

	PT18
	CV
	668139.1
	937901.2
	316.047
	 
	PT278
	SH
	668104.9
	937822.2
	317.161

	PT19
	CV
	668139.5
	937900.4
	316.104
	 
	PT279
	SH
	668105
	937825.4
	317.107

	PT20
	CV
	668137.3
	937899
	317.048
	 
	PT280
	SH
	668103.5
	937827.1
	317.276

	PT21
	SH
	668133.7
	937894.7
	316.106
	 
	PT281
	SH
	668108.1
	937827.2
	317.179

	PT22
	SH
	668136.7
	937894.8
	316.021
	 
	PT282
	SH
	668112
	937827.1
	317.097

	PT23
	BLD
	668137
	937893.5
	316.015
	 
	PT283
	SH
	668116.6
	937827.5
	317.116

	PT24
	SH
	668141.1
	937890.4
	315.886
	 
	PT284
	SH
	668117.8
	937831.4
	317.048

	PT25
	SH
	668145.9
	937889.2
	315.599
	 
	PT285
	SH
	668112.9
	937833.2
	317.012

	PT26
	SH
	668147.8
	937891.6
	315.619
	 
	PT286
	SH
	668108.8
	937832.7
	317.058

	PT27
	GT
	668148.7
	937893.4
	315.804
	 
	PT287
	SH
	668106.3
	937831.7
	317.095

	PT28
	GT
	668147.9
	937894
	315.765
	 
	PT288
	SH
	668120.4
	937780
	318.343

	PT29
	BLD
	668148.9
	937893.2
	315.928
	 
	PT289
	SH
	668125.9
	937783
	318.036

	PT30
	SH
	668148.1
	937886.3
	315.852
	 
	PT290
	SH
	668122.6
	937785.4
	318.043

	PT31
	SH
	668144.4
	937882.9
	315.942
	 
	PT291
	SH
	668120.9
	937789.4
	318.013

	PT32
	SH
	668140.3
	937879.1
	316.287
	 
	PT292
	BLD
	668120.6
	937791.6
	317.908

	PT33
	SH
	668144.4
	937877.2
	316.236
	 
	PT293
	SH
	668125
	937790.3
	317.853

	PT34
	SH
	668147.4
	937877.9
	316.065
	 
	PT294
	SH
	668128.5
	937785.7
	317.944

	PT35
	BLD
	668149.4
	937879.9
	315.956
	 
	PT295
	SH
	668133
	937781.5
	317.952

	PT36
	BLD
	668156.1
	937879.6
	315.966
	 
	PT296
	SH
	668132.9
	937786.5
	317.857

	PT37
	BLD
	668156
	937874.1
	315.966
	 
	PT297
	SH
	668132.2
	937790.7
	317.807

	PT38
	EP
	668150.9
	937875.2
	316.093
	 
	PT298
	SH
	668137
	937790.8
	317.772

	PT39
	SH
	668152
	937878.1
	315.912
	 
	PT299
	SH
	668139.7
	937786.5
	317.824

	PT40
	BLD
	668146.3
	937874.1
	316.297
	 
	PT300
	SH
	668140
	937781.4
	318.046

	PT41
	SH
	668132
	937896.8
	316.129
	 
	PT301
	SH
	668144.3
	937781.2
	318.023

	PT42
	BLD
	668128.4
	937894.7
	316.378
	 
	PT302
	SH
	668145.5
	937786.4
	317.727

	PT43
	SH
	668124.8
	937894.3
	316.451
	 
	PT303
	SH
	668146
	937791.2
	317.717

	PT44
	SH
	668121.3
	937892
	316.499
	 
	PT304
	SH
	668149.5
	937790.8
	317.75

	PT45
	SH
	668118.3
	937894.3
	316.594
	 
	PT305
	SH
	668149.7
	937786.7
	317.692

	PT46
	SH
	668115.7
	937888.6
	316.573
	 
	PT306
	SH
	668148.9
	937781.3
	317.842

	PT47
	BLD
	668113.6
	937886.9
	316.529
	 
	PT307
	BLD
	668150.4
	937781.4
	317.8

	PT48
	SH
	668110.4
	937889.4
	316.736
	 
	PT308
	BLD
	668150
	937791.5
	317.803

	PT49
	SH
	668108.3
	937891.8
	316.596
	 
	PT309
	SH
	668113.7
	937768.9
	318.789

	PT50
	SH
	668104.4
	937892.2
	316.593
	 
	PT310
	SH
	668113.6
	937766
	318.901

	PT51
	SH
	668104.2
	937889.1
	316.626
	 
	PT311
	BLD
	668112.8
	937763.3
	319.05

	PT52
	SH
	668117.5
	937886.8
	316.551
	 
	PT312
	SH
	668117.2
	937761.4
	318.943

	PT53
	SH
	668119.7
	937883.9
	316.541
	 
	PT313
	SH
	668117.5
	937764.3
	318.911

	PT54
	SH
	668117.1
	937883.2
	316.562
	 
	PT314
	SH
	668122.4
	937765.5
	318.977

	PT55
	SH
	668114.2
	937882.6
	316.592
	 
	PT315
	SH
	668124.5
	937762.3
	318.933

	PT56
	BLD
	668113.5
	937874.4
	316.659
	 
	PT316
	SH
	668122.4
	937758.6
	318.969

	PT57
	SH
	668115.5
	937874
	316.641
	 
	PT317
	SH
	668121.7
	937753.2
	319.012

	PT58
	SH
	668117.6
	937873.9
	316.666
	 
	PT318
	SH
	668119.4
	937752.3
	319.022

	PT59
	SH
	668116.9
	937866.3
	316.759
	 
	PT319
	BLD
	668113
	937752.1
	319.283

	PT60
	SH
	668114.9
	937865.7
	316.81
	 
	PT320
	BLD
	668113.1
	937748.7
	319.275

	PT61
	SH
	668112.2
	937865.8
	317.066
	 
	PT321
	BLD
	668113.2
	937730.1
	319.819

	PT62
	BLD
	668111.7
	937870.2
	316.664
	 
	PT322
	BLD
	668118.1
	937726.7
	320.172

	PT63
	SH
	668124
	937868.3
	316.542
	 
	PT323
	BLD
	668118.2
	937750.2
	319.117

	PT64
	BLD
	668129.2
	937867.4
	316.594
	 
	PT324
	SH
	668122.5
	937751.6
	319.006

	PT65
	SH
	668128.1
	937869.8
	316.579
	 
	PT325
	SH
	668124.5
	937754.3
	318.972

	PT66
	SH
	668127.9
	937872.5
	316.566
	 
	PT326
	SH
	668125.4
	937757
	318.942

	PT67
	SH
	668125
	937873.8
	316.569
	 
	PT327
	SH
	668126.4
	937759.8
	318.902

	PT68
	SH
	668123.6
	937877
	316.822
	 
	PT328
	SH
	668127.7
	937763.6
	318.945

	PT69
	SH
	668126
	937879.4
	316.682
	 
	PT329
	SH
	668129.6
	937766.7
	319.003

	PT70
	SH
	668121.7
	937869.6
	316.558
	 
	PT330
	SH
	668132.3
	937766.4
	319.052

	PT71
	SH
	668121.5
	937862
	316.817
	 
	PT331
	SH
	668132.9
	937763.9
	319.098

	PT72
	SH
	668123.1
	937858.4
	316.857
	 
	PT332
	SH
	668133.1
	937760.8
	318.995

	PT73
	SH
	668118.9
	937856.2
	316.91
	 
	PT333
	SH
	668133.8
	937757.1
	318.991

	PT74
	BLD
	668120.4
	937852
	316.833
	 
	PT334
	SH
	668134
	937753.4
	318.981

	PT75
	SH
	668116.8
	937852.9
	316.833
	 
	PT335
	SH
	668134.5
	937750.7
	319.07

	PT76
	CV
	668119
	937855.1
	316.791
	 
	PT336
	BLD
	668137.6
	937750.4
	319.035

	PT77
	CV
	668118.5
	937855.2
	316.819
	 
	PT337
	SH
	668138.2
	937752.8
	319.024

	PT78
	SH
	668111.8
	937851.5
	317.396
	 
	PT338
	BLD
	668140.6
	937755.3
	318.91

	PT79
	SH
	668115.7
	937850.6
	316.866
	 
	PT339
	SH
	668137.7
	937757.7
	319.018

	PT80
	SH
	668118.3
	937849
	316.835
	 
	PT340
	SH
	668136
	937762
	319.013

	PT81
	SH
	668118.1
	937843.1
	316.939
	 
	PT341
	SH
	668138.3
	937764.7
	319.044

	PT82
	SH
	668113.8
	937842.7
	316.91
	 
	PT342
	BLD
	668139.4
	937765.7
	319.051

	PT83
	SH
	668108.1
	937843.3
	317.4
	 
	PT343
	SH
	668141.4
	937749.2
	319.111

	PT84
	SH
	668106.1
	937847.2
	317.641
	 
	PT344
	SH
	668143.4
	937751
	319.05

	PT85
	SH
	668102.4
	937849.2
	317.563
	 
	PT345
	SH
	668144.9
	937753.8
	318.948

	PT86
	SH
	668101.2
	937843.6
	317.586
	 
	PT346
	SH
	668147.2
	937751.6
	318.691

	PT87
	SH
	668099.2
	937840.3
	317.489
	 
	PT347
	SH
	668146.9
	937747.9
	319.135

	PT88
	SH
	668098.1
	937836.4
	317.051
	 
	PT348
	SH
	668144.5
	937745.9
	319.098

	PT89
	SH
	668094.9
	937829.9
	317.405
	 
	PT349
	SH
	668143.8
	937741.8
	319.252

	PT90
	SH
	668099
	937830
	317.366
	 
	PT350
	BLD
	668137.8
	937739.5
	319.454

	PT91
	SH
	668102.2
	937835.3
	317
	 
	PT351
	SH
	668140
	937740.1
	319.295

	PT92
	SH
	668093
	937842.7
	317.597
	 
	PT352
	SH
	668141.4
	937742
	319.263

	PT93
	SH
	668090.5
	937849.3
	317.02
	 
	PT353
	SH
	668145.1
	937740.6
	319.475

	PT94
	SH
	668088
	937845.4
	317.154
	 
	PT354
	SH
	668147.6
	937743.1
	319.297

	PT95
	CV
	668089.1
	937840.1
	317.01
	 
	PT355
	SH
	668149.8
	937746.8
	319.15

	PT96
	CV
	668089.5
	937840.1
	317.036
	 
	PT356
	SH
	668151.4
	937750.4
	319.144

	PT97
	CV
	668089.7
	937835.1
	316.97
	 
	PT357
	SH
	668153.9
	937753.9
	319.13

	PT98
	CV
	668089.1
	937835.1
	316.951
	 
	PT358
	BLD
	668156.8
	937753.8
	319.16

	PT99
	SH
	668087.3
	937837.4
	317.032
	 
	PT359
	BLD
	668155
	937750.1
	319.175

	PT100
	SH
	668084.9
	937841.3
	317.015
	 
	PT360
	GT
	668156.7
	937750.4
	319.189

	PT101
	SH
	668081.1
	937845.6
	316.694
	 
	PT361
	GT
	668156.4
	937744
	319.379

	PT102
	BLD
	668082.4
	937849.5
	316.774
	 
	PT362
	BLD
	668151.3
	937744.1
	319.293

	PT103
	SH
	668079.2
	937850.8
	316.576
	 
	PT363
	BLD
	668157.6
	937720.9
	319.595

	PT104
	SH
	668076.3
	937851.1
	316.606
	 
	PT364
	BLD
	668075.3
	937717.9
	320.555

	PT105
	SH
	668076.4
	937857.2
	316.522
	 
	PT365
	BLD
	668042.2
	937720.6
	320.353

	PT106
	SH
	668079.6
	937859
	316.481
	 
	PT366
	BLD
	668036
	937729.4
	320.261

	PT107
	SH
	668082.3
	937859.3
	316.539
	 
	PT367
	BLD
	668035.2
	937744.9
	319.623

	PT108
	SH
	668081.6
	937865.3
	316.444
	 
	PT368
	BLD
	668011
	937744.6
	320.389

	PT109
	SH
	668078.7
	937867
	316.454
	 
	PT369
	BLD
	668000.4
	937749.6
	319.55

	PT110
	SH
	668075.8
	937866.3
	316.351
	 
	PT370
	BLD
	667993.6
	937757.8
	318.942

	PT111
	SH
	668074
	937869.4
	316.329
	 
	PT371
	BLD
	667980.6
	937772.8
	318.59

	PT112
	SH
	668078.7
	937870.4
	316.547
	 
	PT372
	BLD
	667974.3
	937782.4
	318.279

	PT113
	SH
	668081.1
	937872.7
	316.472
	 
	PT373
	BLD
	667968.1
	937789.6
	318.03

	PT114
	SH
	668081.9
	937877.2
	316.469
	 
	PT374
	RD
	667966.1
	937793.6
	317.734

	PT115
	SH
	668079
	937877.3
	316.472
	 
	PT375
	CL
	667964.4
	937795.8
	317.839

	PT116
	SH
	668076.3
	937876
	316.604
	 
	PT376
	RD
	667962.9
	937797.2
	317.658

	PT117
	EP
	668074.3
	937876.1
	316.594
	 
	PT377
	SH
	667967.3
	937798.1
	317.599

	PT118
	TM
	668071.8
	937879
	316.342
	 
	PT378
	SH
	667972.1
	937795.5
	317.821

	PT119
	TM
	668076.7
	937878.8
	316.445
	 
	PT379
	SH
	667976.9
	937798.1
	317.559

	PT120
	TM
	668077.2
	937885.8
	316.536
	 
	PT380
	SH
	667975.5
	937802
	317.229

	PT121
	SH
	668079.9
	937885
	316.362
	 
	PT381
	SH
	667973.8
	937805.3
	317.111

	PT122
	SH
	668082.8
	937883.4
	316.48
	 
	PT382
	SH
	667974.4
	937809.3
	317.087

	PT123
	SH
	668079.8
	937880.6
	316.437
	 
	PT383
	SH
	667980.3
	937808.6
	317.008

	PT124
	SH
	668064.8
	937896.9
	315.429
	 
	PT384
	SH
	667986.3
	937808.3
	317.055

	PT125
	BLD
	668064.8
	937885.4
	315.743
	 
	PT385
	SH
	667989
	937806.7
	317.471

	PT126
	SH
	668069.7
	937888.7
	315.93
	 
	PT386
	SH
	667991.4
	937808.2
	317.321

	PT127
	SH
	668069.8
	937882.8
	315.817
	 
	PT387
	BLD
	667995.8
	937809.1
	317.181

	PT128
	EP
	668066.9
	937881.4
	316.367
	 
	PT388
	BLD
	667996.6
	937819.4
	317.014

	PT129
	BLD
	668073.2
	937873.9
	316.28
	 
	PT389
	BLD
	667997.1
	937825.8
	316.715

	PT130
	SH
	668076.5
	937842.5
	316.803
	 
	PT390
	BLD
	667997.7
	937836.1
	316.436

	PT131
	SH
	668080.9
	937837.3
	316.882
	 
	PT391
	SH
	667999.8
	937837.9
	316.489

	PT132
	SH
	668076.4
	937833.4
	317.117
	 
	PT392
	SH
	668004.1
	937837
	316.697

	PT133
	SH
	668079.1
	937829.3
	317.088
	 
	PT393
	SH
	668006.3
	937835.7
	316.836

	PT134
	SH
	668084.6
	937829.3
	317.095
	 
	PT394
	SH
	668012.2
	937839.5
	317.101

	PT135
	SH
	668084.6
	937825.2
	317.166
	 
	PT395
	BLD
	668024
	937834.2
	316.943

	PT136
	SH
	668080.9
	937824.4
	317.192
	 
	PT396
	EP
	668028.4
	937833.8
	316.701

	PT137
	EP
	668075.2
	937830.8
	317.409
	 
	PT397
	SH
	668027.3
	937830.5
	316.834

	PT138
	SH
	668076.5
	937824.8
	317.309
	 
	PT398
	SH
	668024.8
	937827.5
	316.95

	PT139
	SH
	668080.1
	937820.9
	317.285
	 
	PT399
	SH
	668027.4
	937825.1
	316.977

	PT140
	SH
	668083.9
	937818.9
	317.208
	 
	PT400
	SH
	668025.7
	937818
	317.088

	PT141
	SH
	668084.3
	937814.6
	317.38
	 
	PT401
	BLD
	668022.6
	937817.1
	317.238

	PT142
	SH
	668080.3
	937812.9
	317.483
	 
	PT402
	SH
	668025.6
	937813.3
	317.258

	PT143
	SH
	668077
	937811.8
	317.722
	 
	PT403
	SH
	668030.1
	937809.1
	317.516

	PT144
	EP
	668075.5
	937812.1
	317.622
	 
	PT404
	BLD
	668031.1
	937802.8
	317.66

	PT145
	CV
	668075.9
	937810.5
	317.869
	 
	PT405
	SH
	668027.5
	937801.2
	317.556

	PT146
	CV
	668076.6
	937810.4
	317.877
	 
	PT406
	SH
	668031.4
	937799.3
	317.671

	PT147
	CV
	668076.1
	937808
	317.884
	 
	PT407
	BLD
	668035
	937801.7
	318.075

	PT148
	CV
	668076.5
	937808
	317.896
	 
	PT408
	SH
	668032
	937800
	317.586

	PT149
	BLD
	668073.4
	937815.4
	317.468
	 
	PT409
	SH
	668031.4
	937796
	317.74

	PT150
	BLD
	668073.5
	937803.4
	317.824
	 
	PT410
	SH
	668033.4
	937793.9
	317.725

	PT151
	SH
	668077.3
	937804.7
	317.737
	 
	PT411
	BLD
	668035.2
	937792.8
	317.863

	PT152
	SH
	668080.4
	937805.5
	317.546
	 
	PT412
	BLD
	668029.7
	937792.2
	318.048

	PT153
	SH
	668083.8
	937807.7
	317.514
	 
	PT413
	BLD
	668029.5
	937779.7
	318.482

	PT154
	SH
	668084
	937803.1
	317.576
	 
	PT414
	BLD
	668035.6
	937839.2
	316.76

	PT155
	SH
	668080.5
	937801.9
	317.645
	 
	PT415
	BLD
	668030
	937849.5
	316.014

	PT156
	SH
	668076.8
	937799.4
	318.005
	 
	PT416
	BLD
	668014.7
	937849.8
	315.771

	PT157
	SH
	668080.5
	937797
	317.729
	 
	PT417
	RD
	668001.4
	937850
	315.553

	PT158
	SH
	668084.2
	937798.5
	317.584
	 
	PT418
	RD
	667996.5
	937852.3
	315.646

	PT159
	SH
	668086.6
	937795.5
	317.625
	 
	PT419
	BLD
	668015.4
	937870.2
	315.216

	PT160
	SH
	668088.9
	937794.7
	317.784
	 
	PT420
	RD
	668022.4
	937889
	314.617

	PT161
	SH
	668087.8
	937791.7
	318.04
	 
	PT421
	RD
	668020.3
	937890.7
	314.467

	PT162
	BLD
	668090.2
	937790.5
	318.057
	 
	PT422
	BLD
	668035.6
	937896.8
	314.523

	PT163
	SH
	668086
	937790
	318.019
	 
	PT423
	CV
	668032.5
	937898.1
	314.441

	PT164
	SH
	668079.9
	937790.6
	317.829
	 
	PT424
	CV
	668032.1
	937898.6
	314.354

	PT165
	SH
	668076.8
	937791.1
	317.997
	 
	PT425
	EP
	668026.8
	937902.6
	314.367

	PT166
	EP
	668075.9
	937791.5
	318.028
	 
	PT426
	EP
	668042.4
	937923.4
	313.423

	PT167
	SH
	668081.3
	937788.3
	317.911
	 
	PT427
	EP
	668045.7
	937913.1
	313.825

	PT168
	SH
	668086.2
	937787
	318.037
	 
	PT428
	CV
	668045.7
	937915.3
	314.041

	PT169
	SH
	668088.3
	937782.1
	318.256
	 
	PT429
	CV
	668045.2
	937915.7
	314.017

	PT170
	SH
	668083.1
	937782.1
	318.113
	 
	PT430
	RD
	668050.4
	937924.9
	313.193

	PT171
	SH
	668077.2
	937783.1
	318.448
	 
	PT431
	RD
	668048
	937928.1
	313.163

	PT172
	SH
	668077.1
	937779.4
	318.482
	 
	PT432
	CL
	668049.6
	937927.2
	313.142

	PT173
	SH
	668080.8
	937779.2
	318.382
	 
	PT433
	BLD
	668057.8
	937924.9
	313.443

	PT174
	SH
	668086.1
	937777
	318.527
	 
	PT434
	BLD
	668139.5
	937920.4
	313.76

	PT175
	SH
	668088.4
	937774.7
	318.351
	 
	PT435
	BD
	668156.3
	937920.7
	312.957

	PT176
	CV
	668076.7
	937775.7
	318.733
	 
	PT436
	BLD
	668156.4
	937893.6
	315.143

	PT177
	CV
	668076.4
	937775.7
	318.755
	 
	PT437
	BLD
	668120.5
	937803.6
	317.77

	PT178
	SH
	668075.6
	937773.1
	318.598
	 
	PT438
	SH
	668121.8
	937806.3
	317.702

	PT179
	BLD
	668073.5
	937768.6
	318.708
	 
	PT439
	BLD
	668120.3
	937810
	317.679

	PT180
	SH
	668073.1
	937767.9
	318.686
	 
	PT440
	SH
	668124.2
	937808.2
	317.693

	PT181
	SH
	668075.1
	937765.4
	318.807
	 
	PT441
	SH
	668124.2
	937805.5
	317.683

	PT182
	BLD
	668076.2
	937763
	318.99
	 
	PT442
	SH
	668127.7
	937808.3
	317.623

	PT183
	SH
	668077.8
	937762.3
	318.92
	 
	PT443
	SH
	668129.9
	937805.3
	317.555

	PT184
	SH
	668079.4
	937758.5
	319.226
	 
	PT444
	SH
	668132.3
	937808.2
	317.557

	PT185
	SH
	668076.9
	937758.6
	318.98
	 
	PT445
	SH
	668135.2
	937805
	317.569

	PT186
	SH
	668079.6
	937754.5
	319.302
	 
	PT446
	SH
	668139.8
	937808.7
	317.523

	PT187
	SH
	668077.8
	937753.6
	319.218
	 
	PT447
	SH
	668142.5
	937806.5
	317.477

	PT188
	SH
	668078.5
	937746.8
	319.408
	 
	PT448
	SH
	668143.5
	937805.6
	317.641

	PT189
	SH
	668076.3
	937744
	319.51
	 
	PT449
	BLD
	668152.8
	937810.8
	317.334

	PT190
	SH
	668079.7
	937740.7
	319.611
	 
	PT450
	BLD
	668152.8
	937803.9
	317.388

	PT191
	SH
	668080.3
	937743.2
	319.569
	 
	PT451
	BLD
	668120.4
	937826.9
	317.189

	PT192
	SH
	668078.8
	937739.9
	319.631
	 
	PT452
	SH
	668123.3
	937828
	316.989

	PT193
	SH
	668078.8
	937737.1
	319.719
	 
	PT453
	SH
	668126.8
	937828.7
	316.943

	PT194
	SH
	668081
	937736.3
	319.732
	 
	PT454
	SH
	668126.3
	937832
	316.931

	PT195
	SH
	668078.1
	937736.2
	319.726
	 
	PT455
	SH
	668123.9
	937832.8
	316.937

	PT196
	SH
	668074.3
	937736.5
	319.73
	 
	PT456
	SH
	668121.8
	937833.5
	316.965

	PT197
	BLD
	668076
	937739.9
	319.718
	 
	PT457
	SH
	668128
	937833
	316.904

	PT198
	SH
	668070.5
	937735
	319.725
	 
	PT458
	SH
	668128.4
	937836.4
	316.889

	PT199
	SH
	668067.7
	937732.6
	319.769
	 
	PT459
	SH
	668135.6
	937832.3
	316.921

	PT200
	SH
	668065.8
	937735.6
	319.673
	 
	PT460
	SH
	668134.3
	937834.4
	316.926

	PT201
	SH
	668064.2
	937739.6
	319.579
	 
	PT461
	SH
	668138.4
	937829.2
	316.911

	PT202
	SH
	668061
	937736.3
	319.632
	 
	PT462
	SH
	668141.1
	937835.5
	316.628

	PT203
	SH
	668060.3
	937732.6
	319.705
	 
	PT463
	SH
	668120.5
	937838.7
	317.002

	PT204
	SH
	668057.4
	937735.8
	319.652
	 
	PT464
	BLD
	668073.3
	937862.2
	316.453

	PT205
	SH
	668056.3
	937739.5
	319.449
	 
	PT465
	SH
	668072.4
	937859
	316.477

	PT206
	SH
	668052.5
	937736.1
	319.664
	 
	PT466
	SH
	668069.5
	937857
	316.409

	PT207
	SH
	668050.9
	937732.6
	319.757
	 
	PT467
	SH
	668065.8
	937859.2
	316.319

	PT208
	SH
	668048.6
	937736.2
	319.724
	 
	PT468
	SH
	668064.3
	937857.5
	316.229

	PT209
	BLD
	668043.3
	937739.9
	319.659
	 
	PT469
	SH
	668063.9
	937853.2
	316.483

	PT210
	BLD
	668043.6
	937731.8
	319.686
	 
	PT470
	SH
	668055.7
	937859.2
	316.296

	PT211
	BLD
	668075.8
	937729.8
	319.966
	 
	PT471
	SH
	668050.3
	937854.7
	316.365

	PT212
	BLD
	668079.9
	937728.9
	320.175
	 
	PT472
	BLD
	668050.1
	937852.9
	316.654

	PT213
	BLD
	668079.7
	937763.4
	318.77
	 
	PT473
	SH
	668056.8
	937852.8
	316.47

	PT214
	SH
	668080.8
	937767.6
	318.711
	 
	PT474
	SH
	668063.8
	937852.2
	316.438

	PT215
	SH
	668083.6
	937771.3
	318.618
	 
	PT475
	SH
	668067.5
	937853.8
	316.473

	PT216
	CV
	668088.4
	937773.9
	318.388
	 
	PT476
	BLD
	668073.3
	937851.7
	316.674

	PT217
	CV
	668088.4
	937774.1
	318.401
	 
	PT477
	BLD
	668073.4
	937838.8
	317.02

	PT218
	CV
	668088.9
	937774.3
	318.362
	 
	PT478
	SH
	668071.2
	937834.5
	316.988

	PT219
	CV
	668089.2
	937774.2
	318.355
	 
	PT479
	SH
	668071.7
	937829.5
	317.224

	PT220
	CV
	668089.7
	937774
	318.348
	 
	PT480
	BLD
	668073.4
	937827.2
	317.205

	PT221
	CV
	668089.7
	937773.6
	318.358
	 
	PT481
	SH
	668067.6
	937828.1
	317.111

	PT222
	SH
	668092.5
	937776.3
	318.551
	 
	PT482
	SH
	668064.6
	937832.8
	317.034

	PT223
	SH
	668090.5
	937779.5
	318.338
	 
	PT483
	SH
	668061.8
	937837.4
	316.978

	PT224
	SH
	668092.9
	937780.6
	318.233
	 
	PT484
	SH
	668056.2
	937836.7
	316.98

	PT225
	SH
	668091.7
	937784.1
	318.136
	 
	PT485
	SH
	668057.4
	937831
	317.048

	PT226
	SH
	668090.5
	937787.6
	318.117
	 
	PT486
	SH
	668058.5
	937827.6
	317.15

	PT227
	SH
	668095.2
	937788.3
	318.215
	 
	PT487
	SH
	668050.6
	937828
	316.962

	PT228
	SH
	668098.3
	937788.8
	318.206
	 
	PT488
	SH
	668049.9
	937833.6
	316.97

	PT229
	SH
	668098.2
	937786.1
	318.204
	 
	PT489
	SH
	668049
	937837
	316.957

	PT230
	SH
	668097.9
	937782.4
	318.229
	 
	PT490
	BLD
	668043.9
	937838
	317.267

	PT231
	SH
	668097.4
	937777.8
	318.321
	 
	PT491
	BLD
	668073.7
	937792
	318.073

	PT232
	SH
	668097.1
	937773.1
	318.529
	 
	PT492
	SH
	668073.1
	937784.7
	318.318

	PT233
	SH
	668100.9
	937773.3
	318.58
	 
	PT493
	BD
	668073.2
	937780.3
	318.439

	PT234
	SH
	668102.2
	937777.1
	318.319
	 
	PT494
	SH
	668069.9
	937784.4
	318.355

	PT235
	SH
	668101.1
	937781.3
	318.285
	 
	PT495
	SH
	668064.9
	937790.3
	318.076

	PT236
	SH
	668100.2
	937785.2
	318.239
	 
	PT496
	SH
	668062.6
	937784.4
	318.262

	PT237
	SH
	668102.1
	937788.4
	318.071
	 
	PT497
	SH
	668061.5
	937781.1
	318.253

	PT238
	BLD
	668103.3
	937790.4
	317.873
	 
	PT498
	SH
	668054.5
	937781.3
	318.237

	PT239
	SH
	668105.1
	937786.6
	318.137
	 
	PT499
	SH
	668053
	937785.2
	318.171

	PT240
	SH
	668105.9
	937783.1
	318.189
	 
	PT500
	SH
	668051.4
	937789.3
	318.097

	PT241
	SH
	668106.2
	937778.4
	318.236
	 
	PT501
	SH
	668045
	937791.3
	318.148

	PT242
	SH
	668106.3
	937774.5
	318.368
	 
	PT502
	SH
	668044.7
	937785.9
	318.238

	PT243
	SH
	668106.4
	937771.7
	318.607
	 
	PT503
	BD
	668043.5
	937789.4
	318.204

	PT244
	SH
	668109.8
	937771.4
	318.611
	 
	PT504
	BD
	668046.8
	937781.7
	318.191

	PT245
	SH
	668114.7
	937770.8
	318.727
	 
	PT505
	SH
	668050.5
	937781.3
	318.192

	PT246
	CV
	668118.6
	937769.6
	318.768
	 
	PT506
	BLD
	668073.6
	937768.4
	318.52

	PT247
	CV
	668118.6
	937769.2
	318.875
	 
	PT507
	SH
	668072.8
	937765.9
	318.772

	PT248
	BLD
	668120.4
	937768.5
	318.906
	 
	PT508
	SH
	668068.1
	937767.9
	318.712

	PT249
	SH
	668118
	937771.4
	318.745
	 
	PT509
	SH
	668064.3
	937765.9
	318.846

	PT250
	SH
	668114.6
	937774.6
	318.45
	 
	PT510
	SH
	668061.8
	937764.8
	318.757

	PT251
	SH
	668112.3
	937778.2
	318.273
	 
	PT511
	SH
	668059.2
	937766.6
	318.779

	PT252
	SH
	668116.9
	937781
	318.219
	 
	PT512
	SH
	668056.8
	937767.3
	318.813

	PT253
	SH
	668114.7
	937784
	318.086
	 
	PT513
	SH
	668055.6
	937765.9
	317.208

	PT254
	SH
	668110.9
	937786.4
	318.028
	 
	PT514
	SH
	668054.7
	937765.1
	317.217

	PT255
	SH
	668108.3
	937788.8
	318.063
	 
	PT515
	SH
	668050.4
	937765
	317.161

	PT256
	SH
	668106.5
	937792.3
	317.922
	 
	PT516
	SH
	668048.2
	937766.1
	317.281

	PT257
	SH
	668104.3
	937794.3
	317.593
	 
	PT517
	SH
	668047.6
	937767.1
	318.799

	PT258
	SH
	668106.6
	937796.8
	317.885
	 
	PT518
	BLD
	668043.7
	937764.7
	322.083

	PT259
	SH
	668110.6
	937794.3
	317.866
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